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Abstract

These Application Notes describe a solution comprised of Avaya Communication Server 1000
Release 7.5 (CS1000) and the NetlQ Vivinet Diagnostics 2.3. During the compliance testing,
NetlQ Vivinet Diagnostics was able to work as a network diagnostic tool capable of
determining the cause of failure in the case of degraded voice quality. This test was performed
to verify the basic interaction between Avaya Communication Server 1000 and NetIQ Vivinet
Diagnostics to ensure there is no adverse impact on the CS1000 system or the quality of phone
calls.

Information in these Application Notes has been obtained through DevConnect compliance testing
and additional technical discussions. Testing was conducted via the DevConnect Program at the
Avaya Solution and Interoperability Test Lab.
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1. Introduction

This is the interoperability test report for Avaya Communication Server 1000 Release 7.5
(hereafter referred to as CS1000) and the NetlQ Vivinet Diagnostics 2.3 (hereafter referred to as
Vivinet Diagnostics). This test was performed to verify the basic interaction between CS1000
and NetlQ Vivinet Diagnostics to ensure that there is no adverse impact on the CS1000 system
while NetlQ Vivinet Diagnostics is running and accessing CS1000 systems.

2. General Test Approach and Test Results

The focus of this interoperability compliance testing was primarily to verify Vivinet Diagnostics
does not impact the quality of phone calls when diagnostics is run. For example, diagnostics
were triggered and completed successfully when it receives a QoS0028 trap from the CS1000
Signaling Server.

2.1. Interoperability Compliance Testing

The focus of this compliant testing is to verify that NetlQ Vivinet Diagnostics was able to
interoperate with Avaya CS1000 systems. The following interoperability areas were covered:

e Vivinet Diagnostics can successfully complete a diagnosis when triggered by a
QOS0028 trap sent from CS1K Signaling Server.

e Vivinet Diagnostics correctly frees up the telnet session with the Signaling Server that
it uses.

e Vivinet Diagnostics does not impact the quality of a phone call when diagnostics are
running while a phone call is in progress.

The general test approach was to integrate the Vivinet Diagnostics into CS1000 system. The
main objectives were to ensure that there is no adverse impact on the CS1000 system or any
other management interfaces. The test did not focus on all the scenarios of CS1000 system
failures and all the alarms from all CS1000 devices.

2.2. Test Results

The objectives outlined in Section 2.1 were verified and met. All tests were executed and passed.

2.3. Support

For technical support on NetlQ Vivinet Diagnostics, please contact NetlQ technical support
team:

e Telephone: 1-713-418-5555

e Email: Support@netiq.com

e Web Site: https://www.netiq.com/support/default.asp
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3. Reference Configuration

Figure 1 illustrates the test configuration used during the compliance testing event between
Avaya CS1000 Release 7.5 and NetlQ Vivinet Diagnostics 2.3.

Lab Network

Aveym 1281 ot Avays CS1008 Ria7.5

Hl‘l =—g) -

DR IS

Figure 1: Test Solution Configuration

4. .Equipment and Software Validated

Equipment Software/Firmware
Avaya CS1000 SW Version : 7.50 Q
Avaya Telephones:

12004 (IP) 0602B76

1120E (SIP) 04.01.13.00

1120E (IP) 0624C8A

2050PC (IP) 3.04.0003
Server hosting Vivinet Diagnostics Windows Server 2003 SP2
NetlQ Vivinet Diagnostics SW Version 2.3.15304
NetlQ AppManager Suite SW Version 7.0.1
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5. Configuring the CS1000

This section describes the steps to configure CS1000 to work with the Vivinet Diagnostics.

Here is a summary of CS1000 Configuration:
e [P address of Vivinet Diagnostic’s machine is configured as a trap receiver.
e Setting QoS Zone and Call Basis Threshold Parameters.
e Setting Zone Notification Levels. Insecure shell access enabled.
e Configuring the Call Server to inventory Phones.

5.1. Vivinet Diagnostics Server is configured as a trap receiver.

Access the CS1000 Element Manager via the Unified Communication Manager (Not shown).
Navigate to System > SNMP and configure the IP address of the Server hosting the Vivinet
Diagnostics machine as a trap receiver as shown in Figure 2 below. Under the Options field
check the box for Enable trap sending. All other fields are at default values. Click on Save to
complete the configuration.

AVAyA £81000 Element Manager
_ UCM Network Services Administrator group 1: Iadmingruu;ﬂ = _i
-Home . -
—Links Administrator group 2: Iadmmgmup? *

-%irual Terminals
Qf@ Administrator group 3: Iadmingraup3 *

- Alarms

- Events System management read: W *

- Maintenance

+ Care Equipment System management readhwrite: Iotm321 *

- Peripheral Equipment

+IFP Metwork Alarm

+Interfaces

- Engineered Yalues

+Emergency Serices Trap cammunity: |public

+ Geographic Redundancy

+ Software Alarm threshold: INnne -
=S Alarms below this threshald will be suppressed.
- Routes and Trunks

- Routes and Trunks Options: ¥ Enahle trap sending
- D-Channels Trap Destination:

- Digital Trunk Interface
- Dialing and Numbering Plans P address 1:(10.1010.10 gn1;|162
- Electronic Switched Metwork

- Flexible Code Restriction P address 2;| Por 2;|
- Incoming Digit Translation
- Phones IP address 3:| Paort 3:|
- Templates
- Repors IP address 4:| Port 4:|
- Yiews
- Lists IP address S'I Part S'I
- Properties
- hligration IP address 6:| Fort 6:|
- Tools
+Backup and Restare IP address ?ZI Port ?ZI
- Date and Time
+Logs and reports IP address BZI FPart BZI
- Security
+Passwords
+Palicies

+Login Options —
an e *Required values @ Cancel | »|

Figure 2: Setting up Vivinet Diagnostics Server as a Trap Receiver
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5.2. Setting QoS Zone and Call Basis Threshold Parameters

Access the CS1000 Element Manager via the Unified Communication Manager (Not shown).
Navigate to System > IP Network > QoS Thresholds. Configure the values marked in red
under the QoS Zone Basis Threshold Parameters and QoS Call Basis Threshold Parameters
section as shown in Figure 3 below. All quality metrics that fall outside of the thresholds are
identified by the Alarms script. Click on Save to complete the configuration.

AV/-\Y/-\ CS1000 Element Manager
_UCM Network Services - Lo one basis resnold Farameters -
- Home Input Description Input Yalue
-Links i
Zone Latency ¥Warning Threshold (ZLWT); |20 .
- Virtual Terminals i 4 { ! I (1-100 %)
< (:] Zone Jitter Warning Threshold {(Z.WWT) IZD 1100 %)
+Alarms —
- Maintenance Zone Packet Loss Warning Threshold (ZWPKL). IZD (1100 %)
+Core Equipment . R
- Peripheral Equipment Zone R Factor Warning Threshold {ZWWR) |2D (1-100 %)
“HNodes: Servers, Media Cards Zone Latency Unacceptable Threshold (ZULAT) |2 €1-100 %)
- Maintenance and Repaorts _ —
~ Media Gateways Zone .Jitter Unacceptable Threshold (ZUJIT): |2 (1-100 %)
-Zones .
—Host and Route Tables Zone Packet Loss Unacceptable Threshold (ZUPKL): |2 1100 %3
- Network Address Translation Zone R Factor Unacceptable Threshold (ZUR): |2
—GoS Thresholdg 1.y
- Persomar Ureciories Sample Rate Window (ZARW)] | 300 (B0 - 3600 5
- Unicode Mame Directory
+Interfaces Minimum Sample Count (MS2A0; |100 (501000 )
-Engineered Yalues _
+Emergency Services ‘ QoS Call Basis Threshold Parameters |
SRR RG] Input Description Input Value
+Software : . :
_ Customers Call Latency Warning Threshold (AWLAT): I1 ] (5- 100 ms)
- Routes and Trunks . . | —
_Routes and Trunks Call Jitter YWarning Threshold (W.JIT): |1 0 (5-200 ms)
-D-Channels . l_—
Call Packet Loss Warning Threshold KL): =
- Digital Trunk Interface 4 OAPKLE 10 (5-100 )
- Dialing and Numbering Plans Call R Factor Warning Threshold (2WR): |94 (20-94 )
- Electronic Switched Metwork
-Flexible Code Restriction Call Latency Unacceptable Threshold (ULAT): |1 oo (5-800 ms)
- Incoming Digit Translation [
_ Phones Call Jitter Unacceptable Threshold (UJT): |4E| (5500 ms)
-Templates | —
—Reports Call Packet Loss Unacceptable Threshold {UPKL): I?D (5-250 ) =
- Views . "
Lists Call R Factor Unacceptable Threshold {(UR): IQD (20-04 )
- Properties b Sampling Period (SAMPY: |
~ Migration pling ¢ 5 (5-605) _
-Tools
+Backup and Restore * Yalues entered for WPKL and UPKL represent tenths of a percent.For example a value of 5 represents 0.5%.

- Date and Time /j Refresh | Cancel | =
>

| anc and ranare
2

Figure 3: Configuration of QoS Zone/Call Basis Threshold Parameters
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5.3. Setting Zone Notification Levels

Zone notification levels determine which QoS alarms are sent to the Vivinet Diagnostics as
SNMP traps. The following Table 1 below identifies the notification levels and the
corresponding alarms sent as SNMP traps.

Zone Notification Level Function Alarms Sent as Traps
0 Suppresses all voice quality alarms MNone
1 Allows zone-based Unacceptable alarms  QQOS0017, QOS0018, QOS0019,
Q0S0020
2 Allows zone-based Unacceptable and Q0Ss0012, QOS0013, QOS0014,
Warning alarms Q0OSs0015, QOS0017, QOS0018,
QOSs0019, QOS0020
3 Allows zone-based Unacceptable and QOS0007, QOS0008, QOS0009,
Warning alarms, and per-call Q0OS0010, @OS0012, QOS0013,
Unacceptable alarms QOSs0014, QOS0015, QOS0017,

QO0S0018, QOS0019, QOS0020,
QOS0030, @QOS0031, QOS0032,
QOS50033, Q0S0034, QOS0035,
QOS0036, QOS0037

4 Allows zone-based Unacceptable and Q0S0001, @QOS0002, QOS0003,
Warning alarms, and per-call QOS0005, QOS0007, QOS0008,
Unacceptable and Warning alarms Q0S0009, @OS0010, QOS0012,

QOS0013, @Q0S0014, QOS0015,
QOS0017, QOS0018, QOS0019,
QOS0020, QOS0022, QOS0023,
QOS0024, QOS0025, QOS0026,
QOS0027, QOS0028, QOS0029,
QOS0030, @0s0031, QOS0032,
QOS0033, Q0S0034, QOS0035,
QOS0036, QOS0037

Table 1: Zone Notification Level

If a zone notification level 1s not specifically designated, all QoS alarms fall into the default level
which is 0. Notification level 4 should be enabled in order to receive all possible QoS alarms for
that zone. To set a zone notification level, issue the following command from the CS1000
command line in LD117.

>ld 117

=> CHG ZQNL 1 4; In this example 1 is the zone and 4 is the level.

5.4. Enabling Insecure Shell Access

Vivinet Diagnostics does not support Secure Shell (SSH) access. Instead, it requires Telnet
access.

To enable insecure Shell access on SS:
Log in to the Linux-based Signalling Server and issue the following command,
[admin@cpppm3 ~|$ harden telnet on
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To enable insecure Shell access on CS1000:

Log in to CS1000 command line and issue the following command from overlay LD 117,
>ld 117

=> ENL SHELLS INSECURE

5.5. Configuring the Call Server to Count IP Phones

The Phonelnventory Knowledge Script job uses SNMP to query the Entity MIB on the Call
Server and counts the number of IP telephones in the Entity MIB. This is used by the Vivinet
Diagnostics application for licensing the product against the number of sets that will be
monitored in the CS1000. Inventory of the sets can be reported by running the following
commands in LD 117 of the CS1000 through Command Line Interface.

* CS1000 to generate the inventory report once every midnight

INV MIDNIGHT SETS
* CS1000 to include the telephones from the inventory report in the Entity MIB

INV ENTITY SETS ON
* Optional: CS1000 can also generate the inventory report immediately if required. The above
mentioned two commands generate an inventory report at midnight. If reports need to be run in
real time the following command from LD 117 can be used.
INV GENERATE SETS

Note

- Issue these commands before running the Discovery NortelCS Knowledge Script from the
NetlQ AppManager Application in Section 6.3.

- The inventory report can take hours to complete, based on the number of phones, therefore it
normally runs at midnight. As the task that generates the inventory report on the CS1000 runs at
a low priority, it should not interfere with call processing.

6. NetlQ Vivinet Diagnostics Configuration

This section describes the steps to configure Vivinet Diagnostics for CS1000. This section
assumes that Vivinet Diagnostics has been installed. For more information about installing
Vivinet Diagnostics or about Vivinet Diagnostics system requirements, refer to Section 9[2].
NetlQ AppManager is required for Vivinet Diagnostics Configuration. During the compliance
testing in the lab environment, both these applications were loaded on the same server. The
configurations explained are,

e Configuring SNMP community strings.

e Disabling NetlQ trap receiver.

e AppManager configuration for discovery of CS1000 devices.

e AppManager configuration for receiving alarm traps of CS1000 devices.

e Vivinet diagnostics configuration.
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6.1. Configuring SNMP Community Strings

To enable NetlQ AppManager to use SNMP to access Avaya CS1000 devices, the SNMP
community strings are required to be configured in the AppManager Security Manager.

In the NetlQ server navigate to Start > All Programs > NetlQ > AppManager > Operator
Console (Not Shown). From the AppManager Operator Console window navigate to Extensions
> Security Manager as shown in Figure 4 below.

it NetlQ AppManager Dperator Console (Evaluatlun) on Y\NETIQO14 QDB {Administrator)

File Wiew TreeWView List Graph ES Web |nd0w Help

Bz 2| BERE DS

5 Chart Console
ADChECk
MetIQCEr]

Report i Vlewer

Event Wiewer
Performance Monitor
Computer Managemenk
web Recorder

URL Check Recorder
Diagnostic Consale
Audit Trail

Sawe SOL Password. ..
Cuskomize...

Refresh Tables

| Children

[Jeb [Z [ [@ & | Status

| Comnputer | Krowledge Script

8] ActiveDs 8] CiscolPT S ecurity [ MetBackup
®aD-RT [# CiscalvR MetB ackuplIMEX
[# spplication [# CiscoPersonalbsst [&] MetfinityDrir
E'] ARCserve H CiscolE H MetworkDevice
E'] BackupEzec H Cizcol nity H Metworks-RT
E‘] BES E‘] CizcoUnityEridge E‘] Metworks-FTProsy
I!‘] ElackBerry I!] Cluster I!] MortelBCM
8] CallD statnslysis [l Del [l MoreB M
[ oM &l Darmir [ MorelCT
I!] CizcoCallMar I!] Exchange I!] MortelCS
] Ciscalh 8] Excharge-RT EnT
Ij CizcoCh_4x Ij Exchange2007 Ij Oracle
8] CiscaCME & s & Oracle-RT
[# CiscalCD & MF<P 8] Phonetualiy
[#] CiscolCh & MsCs 8] Prosy
Rl | il
A [»[ ACTION 7, A0 } AMADMIN h ASYNC J DIAG h DISCOVERY £ GENERAL J K56 A N
| User |_Submit Time: |_Stop Time | ;!

Figure 4: Accessing Security Manager

Select the NETIQO01 under Computers as seen on the left window pane of Figure 5. Add the
Custom Label as required and the appropriate community string in Value 1 and then click on the

Apply button when completed.

» For all devices that use the same read-only community string, type default.
Use the default sub-label for Call Server, Network Routing Server (NRS), Element Manager

(EM), and co-resident devices.

* For all devices that use the same read/write community string, type default write.
Use the default write sub-label for all Signaling Servers, VGMCs, MGCs, and MC32Ss.

wiews Help

SLNETINO LW 0DE (administrator)

Jggggl

Computer: NETIGO1

Excharnge | Exch2000-2003 | Oracle | s&P | stMs | sMHeP | saL | WebLDgi

T his infermation is stored in the Apphanager repositon:.

[ SubLabel I

default
default write

FAodifs. |
D elete |

B e

Help |

For Help, press Fi

o [ =

Figure 5: Adding Custom Labels
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6.2. Disabling NetlQ Trap Receiver

This section describes disabling NetIQ Trap Receiver and enabling SNMP Trap Service on
the Vivinet Diagnostics server.
e Access the Services of the NetlQ server by navigating to Start > Administrative Tools
> Services (Not Shown).
e From the Services window select NetIQ Trap Receiver service and disable it (Not
Shown).
e From the Services window select SNMP Trap Service and configure it to start
automatically (Not Shown).
e From the Services window select NetlQ AppManager Client Communication
Manager and NetlQ App Manager Client Resource Monitor and restart these two
services (Not Shown).

6.3. AppManager Configuration for Discovery of CS1000 Devices

This section explains the configuration in the AppManager where the required Knowledge Script
is selected and the values configured so that the elements of CS1000 can be discovered.

During the compliance testing the NortelCS Knowledge Script was used. To access the
NortelCS Knowledge Script open, the Operator Console window as explained in Section 6.1.
Click on DISCOVERY tab shown in the Figure 6 below. Select NortelCS that is seen on the
right hand window pane and drag it to the NETIQO1 that is on the left hand window pane.

r‘, NetI) AppManager Dperator Console (Evaluation) on % \NETIQO01% QDB (Administrator)
File Wiew TreeView List Graph KS Web Extensions Window Help

1

W|x| 2| 2] DiEEE R 95 ke E s B ole|E= B|E 2| =] B
= azte Iﬂ ActiveD5 Iﬂ CizcolPTSecurity Iﬂ MetBackup
& ap-AT ] Ciscalvh NetBackupUNIX
Iﬂ Application Iﬂ CizcoPersonaltest Iﬂ MetfinityDir
Iﬂ ARCzerve Iﬂ CizcollE Iﬂ MetworkD evice
Iﬂ BackupExec Iﬂ Cizcollnity Iﬂ Metworks-RT
Iﬂ BES Iﬂ CizcollnityBridge Iﬂ Metworks-RTFrosy
Iﬂ BlackBerny Iﬂ Clugter Iﬂ MortelBCh
[ CalD atatinalysis el ] NortelBCMx
& cim [ Domina 5
Iﬂ CizcoCallkgr Iﬂ Exchange
Iﬂ CizcolCh Iﬂ Exchange-RT
Iﬂ CizcoCh_4x Iﬂ Exchange2007 Iﬂ Oracle
¥ CiscoCME Eus [ Dracle-RT
& CiscolCD & MFp ¥ PhoreQuality
& CiscolCh [l MsCs & Prowy

Hi< [ [» [P ACTION } AD } AMADMIN } ASYNE b DIAG Ji DISCOVERY JyGENERAL - H

il

Figure 6: Selecting the required Knowledge Script for CS1000
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When the required Knowledge Script is selected and dragged the Properties for
Discovery NortelCS window automatically pops up as shown in Figure 7 below. From this
window select the Values tab and configure the Call Server IP address value and List of
NortelCS devices values. Ensure the box for Discover Phones using the Call Server’s entity
MIB? is checked. Click on OK to continue.

Properties for Discovery_MortelCS E
Schedul@ctions | Objects | Advanced I
Description | Walue | U nitz |

El—r Ewvent Notification

Flaise event if discovery fails? v “es

Flaise event if dizcovery partially succeeds? v Yes

Flaise event if discovery succeeds? [~ ‘es

Call Server

Ligt of MortelCS devices

List of MortelCS device ranges

Full path ta file with list of MortelCS devices

Discovery timeout 1n Minutes

Discover phones using the Call Server's Entity MIB?

Dizcovers Mortel C51000 componentz. Specify a list of devices separated by commas, a range of IP addreszes. and/or a file containing a list of devices. IMPORTAMT: Ensure you have
met all spstem requirementz. installed required Martel patches, configured SNMP community strings. and identified ELAMN addreszses of devices you want ta manitar. Befare running this
script, see ''Perfarming Essential Configuration' in the &pptanager for Mortel C51000 Management Guide. |

E < Ok 1 Cancel Help
4

Figure 7: Configuring the values of Discovery_ NortelCS

Once the properties are configured a job is automatically created that will run and discover all
the CS1000 elements. Figure 8 below shows an example of the job whose status is stopped.
However, a user can start the job manually by clicking on the Traffic Light symbol.

Job Iﬁ Ii} I@ |(fﬂ| Status | Children | Computer | Knowledge Script | Usger | Submit Time | Stop Time | d
.g 607 Stopped 1 HETIGO! MortelC5_GetOMReport METIQO \administrator 34442007 31613 PM 372011 10:51:31 AM
.@ EO5 s Stopped 1 METIGmM MortelC5_Phonel rventory METIOO \administrator — 3/4/20017 20748 P 3/4/2011 31218 PM
.@ 603 § @ Stopped 1 HETIGO! MortelC5_alarms METIOO \administrator 344720017 30234 P 4/29/2017 316:53 P
B01 Stopped 1 HETIGON Discovery_MortelCs METIGO Administrator - 3/4/2017 11:25:14 &M 6/9/2011 1233:53 PM _
.Q 598 ¥ Stopped 1 METIQO MortelCS_Phonelnyventary METIQO \Administrator  2/23/2011 10:40:52 Ak 2/23/2017 10:40:56 Ak
.g ny7 ¥ Stopped 1 METION  MartelCS_HealthCheck METIQO \Admiristratar ~ 2/18/2011 11:56:35 AW 2/21/2011 B16:36 PM
.g 5 ¥ Stopped 1 METIQO MortelC5_Phonelnventary METIQO \Administrator  2/17/2011 10:48:28 AW 2/17/2011 10:48:35 AM
.g 593 8 Stopped 1 METIGmM MortelC5_Phonel rventory METIOO \administrator  2/17/2017 10:45:30 &M 2/17/2017 10:45:53 &AM
.@ sa1 ¥ @ Stopped 1 HETIGO! MortelC5_alarms\ 7 METIOO \administrator - 2/17/2017 8:13:33aM  3/4/2011 23747 PM
.g 589 § @ Stopped 1 METIGmM MortelC5_alarms\ 7 METIQO \administrator  2/17/2017 6:40:41 AW 272017 81231 AM
aimer @ &€ Stopped 1 METIGO  MortelCS_alarmsy'7 METIQO \Administrator ~ 2/16/2011 551:42 PM  3/4/2011 2:38:06 PM j
[ [T o T2 Events A, Jobs £ Details }, Graph Data /
Master | MT | MetworkDevice | Report MortelC5
For Help, press F1 |Computers : 1 [Open Events: 944 [Runining Jobs: 1 [Graph Data: 657 [12:13PM 4
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Figure 8: Window showing the Job Discovery NortelCS

6.4. AppManager Configuration for Alarm of CS1000 Devices

This section explains the configuration in the AppManager where once the CS1000 elements are
discovered the Alarms can be configured so that the Vivinet Diagnostics reports these alarms
when they are triggered by CS1000.

In the Operator Console window of the AppManager make sure that NortelCS Knowledge Script
has been successfully executed and all CS 1000 devices can be found in the AppManager tree
view as shown in Figure 9 below. Select the NORTELCS tab and drag the Alarms script seen
on the right hand window pane to the NortelCS Application System Name that is seen on the
left hand window pane.

r‘, NetIQ AppManager Operator Console (Evaluation} on % \NETIQOD1%0QDB {Administrator)
File Wiew TreeView Lst Graph KS Web Extensions ‘Window Help

B | [E=
[ MortelCS Application: System Mame % BdZ_Callluality
[, &pplication: System Mame .@Eall[:apacity
I:I---,@, Switch:System Mame .@ GetOMReport
I:I---,@, Application: System Name .@ HealthCheck
[]---.g MortelC5 Switch:System Mame .@ Phonelnventary
[+, &pplication: System Mame 'g 55_CalQualty
[#}- MortelCS Application: 5 ystem MNarne 'g SS_EaIIQuaI\t}I test
[#- MortelCS spplication: System Mame .@ SS_H3238tats_
[#- MortelCS Application: System Mame .@ SS_F! -
(-5 Switch:System Mame _Registration
I:I---,@, Application: System Name .@SS_SIPStats )
[:I---,@, Application: System Mame % WGME_Callluaity
- g5 NortelCS Switch:Systemn Name
[+ y5] MortelCS Application: System Mame
|El--- P MortelCS Application: System Name |
[ P Call Server:System Name
----- Ja Signaling ServerSystem Name
----- J5) ECM:Systemn MName
= W« T ¥ [WFERY /L GENERAL J, K56 J, NETWORKDEVICE i NOFTELCS /£ NT Ji NTADMIN J, FEC

Figure 9: Selecting the required Alarm Script for CS1000

When the required Alarm script is selected and dragged the Properties for NortelCS Alarms
window automatically pops up as shown in Figure 10 below. From this window select the
Values tab and configure the required alarms. During compliance testing all alarms under the
Launch Diagnostics when the following alarms are received was selected. Click on OK to
continue.
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Properties for NortelCS_Alarms E

Schedul@cliuns I Dbieclsl Advanced I

Description

Yalue

Monitor “critical to monitor” alarms?
[=F—Monitor Qo5 alarms?
|—Include or exclude alarms?
|—A|alm identifiers [comma separated)
Phone filter

= Launch Diagnostics when the following alarm is received ._.

W ves
v es

Exclude

|

|>'W'arning packet loss Qa500227 [+ Ves
|—W’aming latency Qo500247 [ Yes
|—Warning jitter QoS0O0267 [ Ves
|—Warning Fi-factor QoS00287 W ves
|—Unacceptable packet loss Qo500307 W ves
|—L|nacceplah|e latency Qa500327 v es
L Unacceptable jitker 00500347 [ es
Monitor critical alarms? [« Yes
M onitor major alarms? [ Yes
Monitor minor alarms? [+ Ves
M onitor warning alarms? [ Yes
Monitor info alarms? W ‘es
Monitor cleared alarms? v Tes
(2] bl ik imdeoboeminabo olaema ) & Yes

o

konitars the Appkdanager MortelCS prosy agent for MortelCS alarms. The MortelCS devices send alarms ta the prasy agent using SHIP traps. Therefore, configure the MortelCS devices
to send SMMP traps to the HortelCS proxy agent before using this script. See the MortelCS Management Guide for more information.

o

<o

Cancel

Help |

Figure 10: Configuring the values of NortelCS_Alarms

Once the properties are configured, a job is automatically created that will run and capture all the
alarms that are defined. Figure 11 below shows an example of the job whose status is stopped.
However, a user can start the job manually by clicking on the Traffic Light symbol.

Job |§ |1} |® |(§ﬂ| Statuz | Children | Computer | Knowledge Script | Lser | Submit Time | Stop Time ;I

E07 3 Stopped 1 METIQM MortelCS_GetOMReport METIGO \Administrator  3/4/2011 21619 PM 37772011 10:51:31 &M

605 ¥ Stopped 1 METIGOT MortelC5_Phonelnventory METIQO \administrator  3/4/2017 30748 PM 32420011 31218 PM

E03 @ Stopped 1 METIQO NortelCS_Alams | METIGO \Administrator  3/4/2011 20234 PM - 4/29/2011 316:53 PM

B s B Stopped 1 METIGOT Discovery_MortelCS METIQO \administrator  3/4/20171 11:25:14 AWM B/9/20011 12:33:53 PM _

.@ 599 ¥ Stopped 1 METIGO MortelC5_Phonelnventory METIQO \administrator  2/23/2011 10:40052 8 2/23/20171 10:40:56 AM

.@ na7 Stopped 1 METIQO MortelC5_HealthCheck METIQOTNAdministrator 24182011 11:56:35 4M  2/21/2011 6:16:36 P

.@ 595 ¥ Stopped 1 METIGO MortelC5_Phonelnventory METIQO \administrator  27/2011 10:48:28 aM  2A7/20171 10:48:35 AM
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Figure 11: Window showing the Job NortelCS_Alarms

6.5. Vivinet Diagnostics Configuration

This section explains the configuration in the Vivinet Diagnostics of the SNMP, Call Server and

Signaling Server values of the CS1000.
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Access the NetlQ Vivinet Diagnostics window by navigating to Start > All Programs > NetlQ
Vivinet Diagnostics. Select Options as shown in Figure 12 below. From the Options menu user
can select SNMP, Call Server and Signaling Server to configure their respective values.

Untitled - NetI(] Yivinet Diagnostics

Eile Conkral  Miew  Help

0 Eirewall...

SHMP. ..
Thresholds, ..

Zall Scripks. ..
Qo5 Definitions... a HetIQ Yivinet Diagnostics guides you through a series

Vivinet Diagnostics

Layer & Switch... find the source of ¥YoIP call quality problems on yourr
WRRP...

Before using Wivinet Diagnostics, configure netwark secunty
Ehaone Yendor ... 1Ds/passwords for your Call and Signaling Servers, On the O

SMMP to enterin-use SNMP commmunity strings, Cick Call S
Call Server... ; ) ’ |
= in-use Call Servers, Click Signaling Server to do the same f
Signaling Server. ..
=2 ReR & pefine . ... |
Sleglllizleln... Step Define the Problem to Be Diagnosed.
Vivi I"lEt] M 1 Specify two VolP devices that are affected by a performance
computers running MetIlQ Performance Endpoints, or non-ph
D |ag “ﬂst":s ggzlfee:s::m as routers or gateways, Enter phone numbers,

|

¢ Diaghose

Step Diagnose the Problem.

2 Clicl Diagnose to view the Diagnosis in real time. The Diag
in 3 to 10 minutes, & diagram shows a YolIP Path Trace betw
Devices and updates it dynamically, Click the various icons t
information about intervening devices orlinks, and any issue

i¢ Report

Step Report the Results.

3 After the problem has been diagnosed, check performance t
the quality of calls between the devices, Review a Diagnosis «
Generate a repart in HTML forrmat, or export raw data in JCf

1 | i

|Start Tirne: |Duratiu:un: |Issues: |Createu:| By: User  |License Exp 4

Figure 12: NetIQ Vivinet Diagnostics main screen

To configure the SNMP values, select the SNMP v1/v2 tab and Add the required values as
shown in Figure 13 below. Click on OK to complete the configuration.
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Edit SNMP Configuration E3

— Community Stringz

Ligt the SMMMP community strings uzed in your YWolP netwark.

Cormrnunity String & | Authorization &

ot 23 read-only
otrmd21 read/write —

private read write
public: read-only Delete |

Iy QE. 1 Cancel Help

Figure 13: Editing the SNMP Configuration

To configure the Call Server value, select the Call Server option as shown in Figure 12 above.
Call Server window is presented as shown in Figure 14 below. Click on Add button. Input the
Call Server IP address, User ID and Password. Click on OK to complete the configuration.

Call Server

Click "&dd" ko add a Call Server and SL1 level 1 lagin to the list, |

Call Server ¥ |Llser o IF‘asswu:uru:I I
Add Call Server | x| r Delete

Call Server: I |

ser ID; I

Passwiord; I

i Ik 1 Cancel Help |

k. | Zancel Help

Figure 14: Editing the Call Server Configuration

To configure the Signaling Server value, select the Signaling Server option as shown in Figure
12 above. Signaling Server window is presented as shown in Figure 15 below. Click on Add
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button. Input the Signaling Server IP address, User ID and Password. Click on OK to complete
the configuration.

Signaling Server | x|
Click "Add" to add a Signaling Server and 5L1 level 1 login to the lisk.

Signaling Server ¥ |user 1o+ | Password

Add signaling Server I Delete |

Signaling Server I |

Iser I0: I

Passwiord; I

Y Qi ] Cancel Help |
| Zancel Help

Figure 15: Window showing the Job NortelCS_Alarms

7. Verification Steps

The following tests were conducted to verify the solution between the CS1000 and Vivinet
Diagnostics Application,
e Qo0S0028 alarm was triggered by the CS1000 and Vivinet Diagnostics captured this trap
and provided the details.
e Ensure Vivinet Diagnostics does not interfere with the CS1000 Signaling Server’s
capability of processing commands using Telnet.
e Ensure Vivinet Diagnostics does not impact phone calls when calls are made during a
diagnosis.
e Ensure Vivinet Diagnostics does not impact the quality of a phone call when diagnostics
are run while a phone call is in progress.

8. Conclusion

All of the executed test cases have passed and met the objectives outlined in Section 2. The
NetlQ Vivinet Diagnostics 2.3 is considered compliant with Avaya CS1000 Rls 7.5.

9. Additional References

[1] Product documentation for Avaya products may be found at:
https://support.avaya.com/css/Products/

[2] Product documentation for NetlQ Vivinet Diagnostics may be found at:
https://www.netig.com/support/default.asp?tab=ProductSupport&product=NONE
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™ are registered trademarks or trademarks, respectively, of Avaya Inc. All other trademarks
are the property of their respective owners. The information provided in these Application
Notes is subject to change without notice. The configurations, technical data, and
recommendations provided in these Application Notes are believed to be accurate and
dependable, but are presented without express or implied warranty. Users are responsible for
their application of any products specified in these Application Notes.

Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya
DevConnect Program at devconnect@avaya.com.
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